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Sección DVD a AVI/OGM 

• Introducción: Conceptos AVI, OGM, DivX, Xvid... 

Como seguramente ya sepas, en la actualidad es posible realizar una copia de 
seguridad de un DVD en formatos comprimidos que permiten meter la película en 
CDs, con pérdidas de calidad muy pequeñas. Como se muestra en la parte superior 
de la siguiente imagen, en los DVD las imágenes son completas; mediante la 
compresión a un formato comprimido sólo se recogen las partes de la secuencia 
que varían. En la parte inferior las figuras 1 y 5 son las denominadas Keyframes, 
que son frames o imágenes completas. Entre dos keyframes sólamente cambia en 
pantalla aquellas partes con movimiento. Por ejemplo, durante una conversación el 
fondo queda estático y lo único que varía son las caras de los personajes, por lo 
que no es necesario modificar el fondo y por ello se deja como está. Con esto 
conseguimos comprimir la película. 

 

A continuación cabe definir unos cuantos conceptos que mucha gente no tiene 
claros: 

AVI: es un tipo de archivo contenedor, que puede contener una pista de video 
(codificada con DivX, XviD, etc.) y una o más pistas de audio en formato WMA, 
MP3, AC3, WAV... excepto OGG. Dicho de otro modo, el AVI es la "caja" o 
"envoltura" donde se meten el video y el/los audios. 

OGM: es otro tipo de archivo contenedor, similar al AVI, pero que admite sonido en 
formato OGG y archivos de subtitulos, capitulos, etc. Normalmente cuando tenemos 
un video con sonido OGG, el archivo contenedor no es AVI sino OGM, por tanto la 
extensión del archivo de video debe ser OGM y no AVI. 

DivX: DivX es una forma de compresión de vídeo que usa ciertos algoritmos y 
métodos para lograr su propósito. El codec DivX™ (compresor y descompresor) es 
un codec de video basado en MPEG-4 de gran calidad, que se ha ganado la 
popularidad como el "MP3 del video". Un archivo AVI o un archivo OGM pueden 
contener pistas de video en formato DivX, por tanto está mal decir "tengo un 
archivo DivX", lo correcto sería decir "tengo un archivo AVI/OGM en formato DivX". 

XviD: es un codec que se distribuye totalmente libre (a diferencia del DivX, cuya 
versión Profesional es de pago). Las consideraciones son idénticas a las dadas para 
DivX. La única diferencia es que los algoritmos de compresión de video son 
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distintos en ambos codec. Por lo demás, puedes manejar XviD igual que si fuera 
DivX. 

• Manuales necesarios para crear AVI u OGM 

Actualmente tenemos dos manuales disponibles en la web para crear copias de 
seguridad de DVD, uno con el programa DVD2AVI y otro con el programa Gordian 
Knot. Conviene hacer una comparación entre ambos manuales. Esta comparativa 
puede variar según quién la realice, tenlo en cuenta. 

Característica Gordian Knot DVD2AVI 

Facilidad de uso ** ***** 

Calidad del archivo ***** *** 

Tiempos a emplear Altos Bajos 

Tipos de archivo explicados AVI, OGM AVI 

Formatos de audio explicados MP3, AC3, OGG, dual MP3, dual 

Idioma Español/Inglés Inglés 

Licencia Freeware Freeware 

Como recomendación, utiliza el manual de Gordian Knot. Es más difícil, es más 
largo, pero los resultados merecen la pena. Si lo ves demasiado complicado, 
entonces usa el DVD2AVI. 

I.- DVD a AVI con Gordian Knot: 
- Programas necesarios 
- Primeros pasos 
- Proyecto D2V con DVD2AVI 
- Procesado del audio 
- Creación del AVS con Gordian Knot 
- Compresión del video 
- Unión de video y audio 
- Preguntas frecuentes 

II.- DVD a AVI con DVD2AVI: 
- Programas necesarios 
- Compresión de video 
- Proceso DVD a AVI 
- Compresión del audio 
- Unión de video y audio 
- Preguntas frecuentes 

I.- DVD a AVI con Gordian Knot: 
 

¿Qué programas voy a necesitar? 

1- Necesitarás los codec DivX 5.X de vídeo útiles para comprimir correctamente 
la película. No te hace falta volver a instalarlos si ya los tenías de antes, pero sí es 
cierto que necesitaremos la versión completa, no solo la que decodifica. Por tanto, 
si tienes un pack de codecs con el DivX instalado, no te sirve. Si quisieras crear un 
XviD, igualmente necesitarías los codec XviD. No obstante, el manual está 
explicado para la utilización del codec DivX 5.0.5 
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Descargar codecs de video DivX Pro  

Igualmente, si vamos a crear un archivo con sonido AC3 (Dolby Digital 5.1) o bien 
en OGG Vorbis, necesitaremos estos codec para poder escuchar luego la peli, todos 
están en la sección de codecs. 

2- Necesitaremos el Gordian Knot Rippack. Éste es un pack que, aparte de la 
aplicación que da nombre al paquete, trae programas conocidos dentro tales como 
DVDDecrypter, DVD2AVI, VirtualdubMod o BeSweet. Si ya tenías alguno, no pasa 
nada, pero vamos a utilizar los que vienen dentro del paquete Gordian Knot 
(GKnot) más que nada por sencillez (pero daría igual si usas los que tenías de 
antes). 

Puedes descargar el paquete Gordian Knot en la siguiente dirección (si te lo bajas 
de otro sitio, asegurate coger el RipPack y no el SystemPack): 

Gordian Knot Rippack (imprescindible) 
Actualización a la última versión 

3- Por último, una vez que tengas la película en tu disco duro querrás copiarla en 
un CD. Aquí tienes total libertad para que lo hagas con el programa que quieras. Si 
quieres puedes visitar la sección de grabación para obtener el Nero Burning Rom 
para este fin. 

Primeros pasos 

• Instalar los codec: 

Como dije antes, sólo es necesario instalarse los codec en el caso de que no los 
tuvieras ya instalados. En nuestro caso vamos a usar los codec DivX, por tanto 
necesitaremos la versión completa de estos codec. Asimismo es conveniente 
desactivar el software espía que traen estos codec (que no es peligroso, pero sí 
molesto), todo esto lo encontrarás en la página de descarga del codec. 

• Instalar Gordian Knot: 

Una vez descargado el Gordian Knot (RipPack), ejecutaremos el archivo .exe y lo 
primero que nos sale es una pantalla de licencia que aceptaremos. A continuación, 
se presentan las opciones a instalar. Yo por simplificar instalo todo entero y así me 
evito líos, aunque hay cosas que no usaremos (p. ej. el Robot4Rip o el vStrip). 
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Después nos pide una carpeta donde instalarlo. Durante la instalación se abrirá 
automáticamente una nueva instalación para el VOBSub, completala y luego 
continuará la del Gordian Knot automáticamente. Al finalizar, nos saldrá un 
mensaje como éste: 

 

Nos pregunta si queremos o no borrar la configuración de nuestros codec. Para lo 
que queremos hacer, da igual que selecciones Sí o No. Una vez hecho, finalizará la 
instalación. El aviso dice que si vas a usar la codificación automática de Gordian 
Knot, primero has de abrir Nandub y VirtualDubMod manualmente la primera vez. 

 

Para instalar una actualización de Gordian Knot, basta ejecutar dicha instalación e 
instalarla en el mismo directorio de Gordian Knot (ya sale marcado dicho directorio 
por defecto). Sin complicaciones. 

Ahora vamos a ponerlo en Castellano. Abres Gordian Knot, y arriba verás unas 
pestañas. Ve a Options -> Language y ahí seleccionas el idioma. Después cierras 
el programa 

• Copia del DVD al disco duro: 

El primer paso será extraer los archivos del DVD a nuestro disco duro. Esto lo 
puedes hacer de forma fácil con programas como el DVDDecrypter (incluido en el 
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paquete Gordian Knot), SmartRipper o vStrip (también incluido en el paquete). En 
nuestra sección de Ripeadores encontrarás todo lo necesario. 

Visitar sección de ripeo de DVD 

IMPORTANTE: mientras estés copiando el DVD al disco duro, asegurate de apuntar 
cuál es la pista de audio español (o la que te interese), pues dentro de poco la 
vamos a necesitar. 

Proyecto D2V con DVD2AVI 

Existen distintas versiones de DVD2AVI, todas muy parecidas, y según la versión 
que tengamos de Gordian Knot puede variar la versión de DVD2AVI incluida. Yo voy 
a explicarlo para la 1.76, pero sería similar para otras versiones. Podrías abrir el 
DVD2AVI desde la pestaña Ripeo de GKnot, pero también desde el grupo de 
programas Inicio -> Programas -> Gordian Knot -> Apps -> DVD2AVI 

El DVD2AVI no requiere instalación, lo ejecutamos y ya está. En el menú File le 
damos a Open o bien pulsamos F3. En la pantalla que se abre debemos buscar la 
carpeta donde extrajimos los VOB y seleccionar el primero de los archivos, 
generalmente llamado VTS_01_1.VOB. Aceptamos y nos sale una pantalla File List 
donde podemos ver que ha seleccionado todos los VOB. Pulsamos OK y listo, se 
carga automáticamente nuestra peli. 

 

A continuación vamos a configurar el menú Audio. Selecciona estos valores: 

· Track Number: seleccionamos el número de la pista de audio que apuntamos 
mientras copiabamos el DVD al disco duro. En nuestro ejemplo, la pista de español 
era la 2, por lo que seleccionamos Track 2. 
· Output Method: Demux (AC3, MPA, DTS). 
· 48 -> 44.1 KHz: Off. 

 

Ahora vamos a configurar el menú Video. 
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· iDCD Algorithm: 64-bit Floating Point. 
· Field Operation: None. 
· Color Space: YUV 4:2:2 
· YUV -> RGB: Pc Scale. 
· Luminance Filter: sirve para cambiar brillo y contraste. 
No nos hace falta tocarlo. 
· Clip & Resize: no haremos nada. 

Finalmente le das en el menú File a Save project, le pones 
un nombre al proyecto y le das a Aceptar. Yo suelo llamarlo 
proyecto.d2v por simplificar y se crean el archivo 
proyecto.d2v y proyecto AC3 T01 3_2ch 448Kbps 
48KHz.ac3 (o similar, que es el archivo de sonido). A veces 
en el nombre del archivo de sonido aparece un retraso 
(DELAY) en milisegundos, como ha sido el caso de esta peli: 
proyecto AC3 T02 3_2ch 448Kbps DELAY -80ms.ac3 Si 
te aparece algo similar en el nombre del archivo, apunta el 
valor aparecido (en mi caso, -80ms), y si no hay nada, 
acuérdate de que vale 0. 

Al cabo de unos minutos, se terminará de crear el proyecto y habremos obtenido 
los dos archivos anteriormente citados. Mientras está creándolo, a la derecha nos 
sale una ventana informativa sobre el proceso (si no sale, pulsa F6 para que 
aparezca), donde podemos ver datos interesantes como el tiempo que falta para 
para que acabe de hacer el proyecto. Bien, pues una vez creado, vamos al siguiente 
paso. 

Como nota interesante, podemos eliminar los créditos de la película para así poder 
aumentar el bitrate de la película y por tanto la calidad. Sólo has de jugar con la 
barra inferior de DVD2AVI, seleccionando por ejemplo el trozo de película que va 
desde el principio hasta donde empiezan los créditos. Si no ves la barra inferior de 
DVD2AVI, puede ser porque tu monitor tenga una resolución de 800x600, prueba a 
cambiarla a 1024x768. 

Atención: Cuidado con cerrar el DVD2AVI.  
 

Para los principiantes, es frecuente que se nos vaya la pinza y cerremos el DVD2AVI antes de que finalice la 
creación del proyecto, eso hará que en los siguientes pasos ocurran cosas raras... Avisado/a quedas: deja que 
termine de crearse el proyecto, hasta que no aparezca FINISH en la ventana informativa no toques nada. 

 

Como datos a tener en cuenta, apuntaremos el Aspect Ratio de la película (en 
nuestro caso, fijate que es 4:3) y el Frame Rate (para este caso, 25 fps). Ahora 
vamos a procesar el audio de la película. 

Procesado del audio 

Bien, ahora vamos con el audio. Voy a explicar cómo crear una película con 
cualquiera de estos tres tipos de audio: MP3, AC3 o bien OGG. La elección del 
formato de audio es fundamental antes de hacer la película, conviene dar una 
pequeña explicación: 

- MP3: es el usual, no requiere de filtros ni cosas especiales para escucharlo. La 
calidad no es mala usando bitrates igual o superior a 128 kbps y la compresión es 
buena. Usa sólo 2 canales (sonido Stereo). No nos dará problemas de 
compatibilidad con ningún programa o reproductor. 
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- AC3: es el sonido Dolby Digital Surround con 5.1 canales, ideal si dispones 
sistema de sonido con 5 altavoces + Subwoofer. Es el mismo sonido que trae el 
DVD, por tanto la calidad es máxima. Sin embargo sólo usaremos este sistema en 
películas muy cortas (hablamos de 90 minutos máximo) o en películas de 2 CD, ya 
que este tipo de sonido ocupa mucho, tiene un bitrate de 448 kbps, un segundo de 
audio ocupa 56 Kb, por tanto ¡una hora de sonido ocupa más de 200 Mb! 
Comprenderás que entonces habrá que usar 2 CD para no mermar la calidad del 
video. No obstante se pueden llegar a obtener buenos resultados con pelis cortas 
en 1 CD y grabadas como CD de tamaño extra (CD-XA). 

- OGG: el audio OGG Vorbis (2 canales, Stereo) es un tipo de compresión que está 
ganando terreno al MP3, ya que ocupando lo mismo que éste, da mejor calidad y 
un sonido más nítido y fluido. Tiene alguna desventaja, por ejemplo necesitamos de 
unos filtros para poder escucharlo (ver sección de codecs) y a la hora de pasar a 
VCD, los pasos son distintos (hay que separar el audio OGG, y convertirlo a WAV 
primero), asimismo, los archivos con audio OGG tendrán extensión OGM (el tipo de 
contenedor no es AVI, sino OGM; por ejemplo el contenedor OGM, a diferencia del 
AVI, admite también subtitulos). Hay gente que sitúa el OGG como el codec de 
audio del futuro, quizá eso sea exagerado, pero vamos a explicar cómo crear un 
archivo OGM con audio OGG. 

Las explicaciones acerca del BeSweet que daré aquí son las básicas y necesarias, 
luego el BeSweet tiene muchas más opciones interesantes pero que no trataré en 
este manual. Nota que el tiempo de compresión para MP3 u OGG es elevado pero la 
calidad resultante es muchísimo mejor. Una vez elegido el formato de audio, 
seguimos. 

• Película con sonido MP3 

Vamos a crear un MP3 con bitrate variable (VBR) ya que así se ganará calidad (en 
los puntos donde no haya sonido, no se usará bitrate, y en aquellos puntos donde 
se necesite más, se usará más bitrate). Para ello usamos el programa BeSweet, 
que trae una interfaz de ventana llamada BeSweet-GUI. Arrancamos desde Inicio -
> Programas -> Gordian Knot -> Apps -> BeSweet o bien arrancamos el 
BeSweet-GUI desde la carpeta donde está instalado el GKnot. 

Se abrirá la interfaz del BeSweet, y arriba a la derecha nos aparecerán los 
BeSweet Profiles y ahí seleccionaremos el MP3 para AVI o 
DSPguru_MP3_for_AVI lo cual hará que varíen los demás parámetros que 
aparecen en la ventana. 

 

También encontraremos un menú como el de la imagen derecha, en el cual, una 
vez hecho el paso anterior, iremos al menú Lame 1. En dicho menú 
seleccionaremos las opciones de compresión del MP3. Verás un montón de ellas, 
pero por simplificar, sólo cambiaremos una cosa. Abajo a la izquierda localiza Alt 
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Preset y lo seleccionas, poniendo ABR (Average BitRate o bitrate medio) y 
seleccionando un bitrate para el sonido. En mi caso, elegí 112 kbps porque la 
película era larga, pero podría haber puesto más (128 o 160 p. ej.) según fuera la 
duración o la calidad que quiera obtener. Servirá de ejemplo los 112 kbps. Ése será 
el bitrate medio, pero como dije antes, al ser el bitrate variable, en unos puntos 
usará más y en otros menos según se necesite. Hay más opciones, como marcar 
bitrates máximo y mínimo, etc., pero no voy a tocarlos en el manual, si te 
interesan, pon un mensaje en el foro. 

 

Después, volvemos a la pestaña BeSweet y comprobamos si están correctas las 
rutas: BeSweet.exe (el BeSweet), Azidts.exe (para tratar el audio AC3), Input 
(el archivo AC3 original) y Output (el archivo MP3 resultante, que yo llamé 
sonido.mp3 por simplificar). 

 

Finalmente damos al botón marcado en verde, AC3 to MP3, y empezará a 
convertir. Llevará bastante tiempo dicha conversión (en mi caso, tardó 86 minutos 
en el archivo, que duraba 2 horas y 26 minutos). Se abre una pantalla de Ms-DOS 
donde aparece el tiempo de la película que lleva procesado. 

 

• Película con sonido OGG 

En este caso crearemos un OGG con bitrate variable (VBR) que, al igual que el MP3, 
así se ganará calidad (en los puntos donde no haya sonido, no se usará bitrate, y 
en aquellos puntos donde se necesite más, se usará más bitrate). Para ello también 
usamos el programa BeSweet, o mejor dicho, su interfaz de ventana llamada 
BeSweet-GUI. Arrancamos desde Inicio -> Programas -> Gordian Knot -> 
Apps -> BeSweet o bien arrancamos el BeSweet-GUI desde la carpeta donde está 
instalado el GKnot. 

Se abrirá la interfaz del BeSweet, y arriba a la derecha nos aparecerán los 
BeSweet Profiles y seleccionaremos el OGG de 2 canales o 
DSPguru_Ogg_Vorbis_2ch lo cual hará que varíen los demás parámetros que 
aparecen en la ventana. 
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También encontraremos un menú como el de la imagen derecha, en el cual, una 
vez hecho el paso anterior, iremos al menú AC3 & OGG. Dentro de dicho menú 
seleccionaremos las opciones de compresión del OGG. Vamos al apartado Ogg 
Vorbis (abajo a la izquierda) y podemos hacer dos cosas: 

1- Marcar Quality y dar un valor, a la derecha del valor nos aparecerá el bitrate 
equivalente (un Quality de 0.400 equivale a un bitrate de 127 kbps p. ej.). 

2- Quitar lo de Quality y marcar las tres opciones superiores. En la primera, 
Nominal Bitrate, ponemos el bitrate medio del OGG; en la segunda, Minimum 
bitrate, ponemos el bitrate mínimo al que se puede llegar, ponlo como yo, en 1); y 
en la tercera, Maximum bitrate, el bitrate máximo al que se puede llegar (no creo 
que haga falta ponerlo mayor que 200). 

 

Después, comprobamos si están correctas las rutas: BeSweet.exe (el BeSweet), 
Azidts.exe (para tratar el audio AC3), Input (el archivo AC3 original) y Output (el 
archivo OGG resultante, que yo llamé sonido.ogg por simplificar). 

 

Finalmente damos al botón marcado en verde, AC3 to OGG, y empezará a 
convertir. Llevará bastante tiempo dicha conversión (en mi caso, tardó 98 minutos 
en el archivo, que duraba 2 horas y 26 minutos). Se abre una pantalla de Ms-DOS 
donde aparece el tiempo de la película que lleva procesado. 
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• Película con sonido AC3 

Si vas a usar sonido AC3, recuerda que dije que lo ideal sería usar 2 CD por el 
tema de que el sonido AC3 ocupa una barbaridad. En fin, lo importante es que no 
tienes que hacer nada, el archivo de sonido que sacaste del DVD2AVI será el que 
luego metas directamente en el AVI. 

Creación del AVS con GKnot 

En este paso vamos a crear un archivo de AviSynth para luego comprimirlo en un 
archivo AVI. Para ello usaremos la aplicación propiamente llamada Gordian Knot. 

Abrimos GKnot y vamos a la pestaña Bitrate (recuerda que, durante el paso de la 
instalación, dije cómo ponerlo en español). En la esquina inferior izquierda verás un 
apartado para abrir el D2V. Pincha en Open y cárgalo, se abrirá una ventana 
automáticamente, y la cierras. Comprueba que al lado de esto, en Frames, se 
hayan seleccionado los FPS a que está la peli (25 en formato PAL Europeo, 23.976 
o 29.976 en formato NTSC Americano). 

A continuación en Modo seleccionas "Calculo Bitrate Medio" y en Duración 
compruebas que se corresponde con la duración que copiaste en el DVDDecrypter o 
en tu reproductor DVD. Finalmente, en Audio A das a "Seleccionar" y cargas el 
archivo de audio que vayas a poner (ya sea en formato MP3, OGG o AC3). Verás 
que sale el tamaño de dicho archivo. Si fueras a hacer una película dual (dos 
audios), cargarías el segundo audio en Audio B. 

 

Luego en Codec seleccionas DivX 5 ya que ése es el que usaremos. Después, por 
este orden, en Interleaving & AVI-Overhead marcamos lo de "Calcular Frame-
Overhead" y luego seleccionamos el tipo de audio que vayamos a usar: si es AC3 o 
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MP3 de bitrate constante (CBR) marca 1x ac3/cbr mp3, y si es OGG o MP3 de 
bitrate variable (VBR) marca 1x vbr-mp3. Igualmente si fueras a añadir dos 
audios elegirías una de las opciones siguientes. En mi caso, p. ej. voy a hacerlo con 
mp3 VBR, pues selecciono lo de la imagen. Después en Tamaño Total 
seleccionamos la capacidad de nuestros CD, en mi caso lo voy a grabar en un CD 
de 90 minutos, meteré 790 Mb en un CD, pero no te alarmes si no usas CDs 
"especiales", marca 700 para un CD de 80 minutos normal. Y para concluir, 
pinchamos en el Nº de CDs que vayamos a usar, yo usaré 1 CD así que pulsé en 1 
CD; igual si fueran 2 o 3 CD. No hace falta marcar lo de "Partir el archivo final en 
CDs" ya que en mi opinión se hará más fácil si hacemos el archivo de una sóla vez 
y luego lo cortamos al final. Verás que en Bitrate Medio nos calcula el bitrate de 
video. Apúntalo (en la imagen, serían 633 kBit/s). Te sorprendería lo exacto que es 
GKnot a la hora de calcular el bitrate, clava las películas en los megas especificados 
a la perfección, con errores en general no superiores a los 5 MB arriba o abajo. 

 

Bien, ahora vamos a meter los cortes en la película. Ve a la pestaña Resolución 
del GKnot. Vuelve a cargar el archivo D2V, se te abrirá una ventana, pero ésta vez 
no la cierras. En dicha ventana, marcas la opción Ver -> Fijar encima con lo cual 
tendremos esa ventana en primer plano y el GKnot en segundo plano. En dicha 
ventana ahora mueve la barra inferior para indicar el inicio de los créditos, y 
cuando tengas localizado dicho punto le das a Seleccionar Inicio Créditos. De 
esta forma los créditos se codificarán con menos calidad que el resto de la película 
(si ya eliminaste los créditos cuando hiciste el proyecto con DVD2AVI, esto no 
necesitas hacerlo). Ahora hecha a un lado la ventana par que no moleste, y en el 
GKnot en el apartado Resolución de Entrada marca lo que apuntaste del 
DVD2AVI (en mi caso, PAL), y en Pixel Aspect Ratio de Entrada marca el aspect 
ratio que apuntaste (yo, 4:3, pero generalmente es 16:9, según lo que te marcase 
el DVD2AVI). 
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Bien, ahora echa la ventana al otro lado y en el GKnot, 
en Crop (Realizar antes que el Resize), pulsas el 
botón "Crop Automático", con lo que el programa nos 
quitará las bandas negras él solito, puedes verlo en la 
ventana que marcaste que quedase encima del todo. Si 
quisieras, puedes eliminar más imagen de forma manual. 

 

Perfecto, pues cogemos y vamos a cambiar la resolución en Resolución de salida. 
Sin cerrar la ventana, vamos moviendo la barra para aumentar o disminuir la 
resolución. En L-Modul y A-Modul seleccionamos 16 (la resolución será múltiplo 
de 16, para mejor compatibilidad en el futuro). Fijate en Aspect Error, es 
indicador de la deformación de la imagen respecto al original. Si se deforma mucho, 
se pone rojo, vigila que el error no sea en valor absoluto mayor del 3% y ya está. 
En mi caso, acabé eligiendo la resolución 512x368 como puedes ver en la imagen. 

 

Bien, en principio está todo, pero hay una cosa de la que no he hablado. ¿Ves 
abajo, en el GKnot, que pone Bits/(Pixel*Frame)? Éso es un indicador de la 
calidad del video resultante, cuanto mayor sea el valor que pone, mayor será la 
calidad. Se ganarán valores más altos si usamos bitrates más altos (es decir, más 
CD o más espacio en un CD) o resoluciones más bajas (hasta cierto punto se puede 
bajar la resolución). Lo que se suele hacer es jugar con los parámetros de 
Resolución y de Nº de CDs para conseguir un valor óptimo. Recomiendo que 
prestes atención al Test de Compresibilidad que explico más adelante. 

Pues sólo queda, en la ventana abierta que está en primer plano, darle a Salvar y 
Codificar, con lo cual se abre una ventana y vemos abajo a la derecha el apartado 
Test de Compresibilidad. No es necesario hacerlo de cara a la compresión de la 
película, pero nos sirve para ver cómo va a quedar y nos ayuda a elegir la 
resolución y el número de CD. Lo activas marcando Si y pones un porcentaje, p. ej. 
4% - 5% es ideal para que no tarde mucho, y le das a Test! 

Tardará unos minutos en acabar, pero cuando lo haga, abajo en 
Bits/(Pixel*Frame) nos saldrá un porcentaje. Hay discusiones sobre a partir de 
qué porcentaje la calidad de la peli es buena, obviamente cuanto mayor sea mejor 
(en la imagen, salió bastante bajo, 40.6%). Se recomienda elegir una resolución 
donde el valor del resultado del test no sea nunca inferior al 40%, estando los 
valores óptimos entre el 60 y el 80%. Aquí está la utilidad del Test de 
Compresibilidad. Si se ve necesario aumentar el porcentaje, podrías usar un CD de 
mayor capacidad o 2 CD (a veces con 2 CD incluso podemos usar sonido AC3) o 
bien bajar algo la resolución pero no se recomienda usar resoluciones demasiado 
pequeñas bajo el riesgo de que se vean pequeños cuadraditos de 1 o 2 mm en la 
imagen. 
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Cuando esté hecho, en la ventana das a Salvar & Codificar y marcas lo mismo 
que en esta imagen. Pero en el apartado Operaciones con Campos es importante 
la utilización de los filtros de desentrelazado en los casos en que se requieran, en 
este caso se recomienda utilizar o el Separate Fields o el Smart Bob. Aqui cada 
uno que pruebe y elija el que mejores resultados dé. En esa misma pantalla donde 
pone Filtro Noise hay veces que puede ser necesaria su utilización en películas 
donde se note mucho el grano fílmico como puede ser en Alien, Minority Report, 
etc. Conseguiremos una mayor compresibilidad, pero su utilización dependerá de 
cada uno. 

 

Finalmente, das abajo en Archivar y guardas el archivo AVS. Si fueses a utilizar la 
codificación automática que tiene el GKnot entonces da a Salvar & Codificar, 
automáticamente se abrirá la pantalla para configurar la codificación automática. 
Ésta es en general más sencilla y no debes tener muchos problemas en configurarla 
(todo aparenta estar bastante claro) pero de momento lo explicaré sin usar dicha 
codificación automática aunque sea un poco más complicado. 

Ya tenemos el AVS listo para codificar. Recuerda bien que el bitrate que te salió (en 
mi caso fue 633 kBit/s) ya que lo necesitaremos en el siguiente paso. Aunque 
GKnot puede codificar por sí mismo de forma relativamente sencilla (desde la 
pestaña Encoder), prefiero explicarlo por separado de GKnot para evitar errores 
que da a veces. Por tanto, podemos cerrar ya el GKnot y ahora comprimiremos el 
video. Sin embargo no es dificil utilizar dicha opción de Encoder, y es muy útil para 
simplificar el proceso. Puedes utilizarla cuando tengas más experiencia con este 
paquete de software. 
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Compresión del video 

Bien, vamos ahora con el video. Para ello abriremos el VirtualdubMod que 
encontraremos en Inicio -> Programas -> Gordian Knot -> Apps -> 
VirtualDubMod. En el menú File -> Open video file... abrimos el archivo AVS 
que habíamos creado en el paso anterior. No digo que lo abras con Open video 
file via AviSynth ya que puede dar error de que no se pudo crear el script. 

A continuación, en el menú Video seleccionas Full processing mode y después 
das a Compression. Se abrirá una ventana donde a la izquierda sale una lista de 
codecs. Selecciona los DivX 5.X y a la derecha pulsa en Configure, se abrirá la 
pantalla de configuración del codec. 

 

En dicha pantalla de configuración, vamos a poner 2 pasadas para el video. En el 
apartado Bitrate donde dice Variable bitrate mode pones Multipass, 1st pass. 
En Encoding bitrate pones el bitrate que nos dio el GKnot, en mi caso fue 633. 
Después en la parte Multipass encoding files pones un archivo .LOG que es 
donde se guardará el análisis de la primera pasada. Yo lo puse en la carpeta donde 
tengo todos los archivos para tener todo siempre bien localizado: 
D:\DVD\proyecto.log 

En algunas versiones del codec DivX puede aparecer la casilla Do not prompt with 
errors and warnings; si aparece márcala. Asimismo en Perfomance/Quality lo 
dejaremos en Standard, que es la opción más rápida. 
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Ahora acepta todo y en el menú File -> Save as... vamos a guardarlo. Selecciona 
un nombre para el archivo, yo siempre lo llamo 1pasada.avi ya que es la primera 
pasada. No se te olvide marcar Don't run this job now; add it to job control so 
I can run it in batch mode para que no empiece a codificar al momento sino que 
lo haga cuando nosotros le mandemos. Asimismo, asegurate que abajo en Video 
Mode ponga Full processing mode. 

 

Bien, ahora configuramos la segunda pasada. Hacemos todo igual, pero en la 
configuración del codec, en donde pone Variable Bitrate mode ahora ponemos 
Multipass, nth pass e igualmente ponemos bitrate (ya vendrá puesto), el mismo 
archivo LOG que al principio, y también ponemos Standard en 
Perfomance/Quality. 

 

Aceptamos todo y como antes, en File -> Save as... lo guardamos como 
2pasada.avi y marcamos lo de Don't run this job now; add it to job control so 
I can run it in batch mode. También asegurate que en Video mode ponga Full 
processing mode. 
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Si fueras a hacer una tercera pasada, sigue los mismos pasos que con la segunda 
pasada, pero llama al archivo 3pasada.avi Con 2 pasadas ya la calidad es muy 
buena, y generalmente nunca habrá que hacer más de 2 pasadas. NOTA: cada 
pasada a partir de la segunda (incluida) ocupará lo mismo que un avi normal sin 
sonido; es decir, tendremos que tener más espacio libre en disco cuantas más 
pasadas demos. La primera pasada ocupa sólo unos poquísimos MB ya que no es 
un AVI real, sino un conjunto de datos y números. 

Finalmente, vamos al menú File -> Job control (también usando la tecla F4) y 
veremos que ahí están nuestros dos archivos esperando ser codificados ("Waiting"). 
Cuando quieras empezar la codificación, dale a Start. Puedes si quieres configurar 
la codificación y dejarlo ahí sin empezar, no se borrará. Es útil si p. ej. lo 
configuramos por la mañana pero queremos empezar la codificación por la noche, 
luego por la noche abrimos el VirtualdubMod y le damos a Start sin tener que 
reconfigurar todo. 

 

Una vez damos a Start, el 1pasada.avi tendrá el Status In progress (en proceso). 
En la ventana damos a OK y en el VirtualdubMod vemos que los menús han 
desaparecido y hay uno sólo llamado Dub in progress! Pues dentro de ese menú 
damos a Show status window y se mostrará la ventana de progreso. Nota que la 
primera pasada ocupa muy pocos megas (seguramente no se pase de 10 Mb), 
luego la segunda, tercera, etc. pasadas ya ocuparán como un avi normal sin sonido 
(unos 600 Mb p. ej. para pelis en 1 CD). 
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Cuando acabe con la primera pasada, automáticamente empezará con la segunda. 
Nota que el tiempo de proceso de la imagen superior es el correspondiente a la 
primera pasada, luego habrá otra pantalla similar para la segunda pasada. 
Normalmente de la segunda pasada en adelante tarda un poco menos que con la 
primera pasada. 

Bien, pues una vez tengamos el video codificado, vamos a ponerle el sonido. 

Unión de video y audio 

También usaremos el VirtualDubMod para este paso. En el menú File -> Open 
video file abrimos el AVI de la última pasada (si hicimos 2 pasadas, será el 
2pasada.avi). A continuación en el menú Video ponemos Direct stream copy y 
ahora vamos al menú Stream -> Stream list. Le damos a ADD y añadimos la 
pista de audio, ya sea en formato MP3, AC3 u OGG. Si nuestro audio es MP3 VBR 
nos saldrá un error como el de la imagen, simplemente pulsa NO. Esto es para que 
nos coja el MP3 como lo que es, VBR, y no CBR. Con audio OGG o AC3 no sale el 
error. 

 

Ahora en dicha ventana tendremos nuestro audio arriba (si fueras a hacer un AVI 
dual, sólo añade después la segunda pista de audio). Si añades más de un audio, el 
audio que esté más arriba será el audio por defecto, el que se escuchará por 
defecto en cualquier reproductor. 
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Ahora pulsamos encima de dicha pista de audio con el botón derecho del ratón y, 
tras verificar que esté marcada la opción de Direct stream copy, le damos a 
Interleaving. Ahí, en Delay audio track by, introducimos el DELAY o retraso de 
audio que apareció en el archivo AC3 que obtuvimos con DVD2AVI, en mi caso 
fueron -80 ms ¿recuerdas? Así evitaremos sonidos desincronizados. Si no obtuviste 
retraso, olvidalo. 

 

Ya está, ahora vamos al menú File -> Save as... y ponemos un nombre 
(definitivo) para el archivo. Igualmente puedes marcar la opción de Segment 
output file si vas a hacer más de 1 CD y poner que corte a los 700 Mb (p. ej.) en 
el apartado correspondiente. Importante: si usaste audio OGG, debes guardarlo 
como tipo OGM en vez de como AVI, ya que OGM es el formato propio para OGG 
Vorbis. Asegúrate además de que abajo del todo está marcado Direct stream 
copy en Video mode. 

 

Salvo imprevistos, ya está hecha nuestra película. Lo normal es que hayamos 
clavado los megas, pues la calculadora de GKnot es muy exacta, si quisieramos 700 
Mb entonces seguramente habremos obtenido entre 698 y 702. 

Preguntas más frecuentes (FAQ) 
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"En teoría no hay diferencia entre teoría y práctica, pero en la práctica sí la 
hay". Si tienes algún problema consulta esta sección por si puedes resolver ahora 
mismo tu duda. 

• ¿Funcionará en mi ordenador?  
• ¿Se pueden leer discos DVD en un lector de CD o en una grabadora?  
• ¿Al convertir el audio se puede mantener el sonido envolvente (AC3 

Surround)?  
• ¿Y podría utilizar audio OGG Vorbis en mi película?  
• El video se ve deformado (por ejemplo las caras alargadas).  
• El video se ve como dando "saltitos".  
• Me ha salido un archivo demasiado grande y no me cabe en 1 CD, o 

bien quiero aumentar la calidad de la película aunque para ello tenga 
que usar 2 Cd's.  

• ¡¡¡El VirtualdubMod nunca para!!!  
• Hay extraños problemas con los bitrate (salen altísimos), o bien sólo 

procesa unos pocos segundos/minutos de peli o bien el archivo de 
audio es muy corto.  

• No me sale el botón de Crop Automático  
• ¿Por qué no se ve la peli en el DVD de mi salón?  

 

• Problema: ¿Funcionará en mi ordenador?  
• Respuesta: 

Los programas utilizados funcionan de Windows 98 en adelante. La mejor 
plataforma para video digital es un Windows de la famila NT, léase 2000, NT, o XP. 
No obstante con Windows 98 también funciona aunque más lento. En cuanto a la 
velocidad del procesador yo lo hago en un Pentium IV a 1500 Mhz con 384 Mb de 
Ram, pero en un Pentium II a 350 Mhz con 64 Mb de Ram funciona perfectamente. 
Por supuesto habrá que tener un buen espacio en el disco duro y mayor paciencia 
cuanto menor sea la velocidad del ordenador. 

• Problema: ¿Se pueden leer DVD en un lector de CD o en una 
grabadora?  

• Respuesta: 

Sencillamente NO. El tipo de compresión de DVD hace que se necesite un tipo de 
láser diferente, de distinta longitud de onda. Tampoco existen "maravillosos 
programas emuladores" que permiten leer DVD, eso es falso. 

• Problema: ¿Al convertir el audio se puede mantener el sonido 
envolvente (AC3 Surround)?  

• Respuesta: 

Con este manual, sí. Sólo lee bien el manual, los pasos están indicados. Lo que 
necesitas es el audio AC3.  

• Problema: ¿Y podría utiilzar audio OGG Vorbis en mi película?  
• Respuesta: 

Sí. Como dije en la FAQ anterior, sólo lee el manual, ahí encontrarás cómo hacerlo. 
En este caso, el archivo obtenido tendrá la extensión OGM. 
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• Problema: El video se ve deformado (por ejemplo las caras 
alargadas).  

• Respuesta: 

El problema es de la relación de aspecto. Tienes que elegir la relación de aspecto 
correcta en el apartado correspondiente del Gordian Knot: generalmente 4:3 para 
películas de pantalla completa, y 16:9 para películas en formato panorámico. 

• Problema: El video se ve como dando "saltitos".  
• Respuesta: 

Puede pasar en ordenadores lentos. Para ello desecha el Windows Media Player, 
que es un devorador de memoria, y utiliza un reproductor que consuma pocos 
recursos como el BsPlayer, ViPlay, Media Player Classic... Asimismo prueba 
cerrando programas residentes como antivirus, firewalls..., también configurando el 
codec para disminuir la calidad de decodificación, y en último caso prueba 
desfragmentando el disco duro. 

• Problema: Me ha salido un archivo demasiado grande y no me cabe 
en 1 Cd, o bien quiero aumentar la calidad de la película aunque para 
ello tenga que usar 2 Cd's.  

• Respuesta: 

Te recomiendo visitar mi guía para partir archivos AVI (puedes quitarle los créditos 
del final). También puedes crear una imagen CD-XA para meter más megas en el 
mismo CD o bien usar CDs de mayor capacidad. 

• Problema: ¡¡¡El VirtualdubMod nunca para!!!  
• Respuesta: 

Pasa a veces que cuando llega al final del marcador de los megas, en vez de 
desaparecer la pantalla de progreso (señal de que ha terminado), sigue pasando el 
tiempo pero los otros marcadores no se mueven (es decir, llega p. ej. a 700 Mb y 
de ahí no pasa). Simplemente aborta el proceso. Lo más normal es que el archivo 
haya salido bien. 

• Problema: Hay extraños problemas con los bitrate (salen altísimos), 
o bien sólo procesa unos pocos segundos/minutos de peli o bien el 
archivo de audio es muy corto.  

• Respuesta: 

Suele ocurrir que a la hora de crear el proyecto con DVD2AVI, no le dejaste 
terminar y cerraste DVD2AVI, con lo cual el proyecto quedó incompleto y sólo le dio 
tiempo a hacer unos minutos. Asegurate de dar tiempo suficiente a la creación del 
proyecto, puedes mirar en la ventana informativa del DVD2AVI cuánto falta (suele 
tardar entre 5 minutos y una hora, en función de la película). Asegúrate, además, 
que la barra inferior del DVD2AVI va del inicio al final, y que sale FINISH en la 
ventana informativa. 

• Problema: No me sale el botón de Crop Automático  
• Respuesta: 

Suele pasar si no tienes abierta en primer plano una ventana con la previa de la 
película. Al abrir el archivo D2V se abre dicha ventana, la primera vez a la hora de 
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calcular bitrate la cerramos, pero la segunda vez a la hora de quitar las bandas 
negras NO la cerramos. 

• Problema: ¿Por qué no se ve la peli en el DVD de mi salón?  
• Respuesta: 

Porque el formato en que la hemos hecho no es reconocido por los DVD, salvo 
aquellos que sí reconocen el formato DivX o XviD. Si quieres verla en un DVD de 
salón normal, sigue una de las guías de Creación de VCD que encontrarás en esta 
misma web. 

 


